Kapitel 13
Grafische
Zusatzanwendungen

Hier folgt eine Beschreibung aller grafischen Zusatzanwendungen, auf die Uber Java-
Clients zugegriffen werden kann und die die Funktionalitdten von i-effect sinnvoll
erganzen.

Keystore-Verwaltung mit dem
i-effect Keymanager

Fir die Verwaltung des eigenen Schlisselpaares und der Partnerzertifikate bietet
sich das im Lieferumfang enthaltene Programm ,i-effect Keymanager” an. i-effect
Keymanager ist ein Programm zur Erstellung, Verwaltung und Prifung von Keystores,
Schlisseln, Zertifikaten, Zertifikatsanfragen und Ricknahme von Zertifikaten. Es ist
ein Open Source Programm das unter der GNU GENERAL PUBLIC LICENSE steht
und somit frei verwendet werden kann. Nach erfolgreicher Installation von i-effect
finden Sie i-effect Keymanager im Verzeichnis /i-effect/<version>/CRYPT/tools unter
dem Namen ,i-effectKeymanager.jar’.

In der Version 1.1 bietet es folgende Funktionen:

0 Erstellung, Laden, Speichern, Léschen und Konvertierung von
Keystores oder Keystore-Eintragen

o Generierung von DSA und RSA Schlisselpaaren mit eigensignier-
ten X.509 Zertifikaten

o Import von X.509 Zertifikaten

o Import von Schlisselpaaren aus PKCS#12
(Public-Key Cryptography Standards) Dateien

o} Passwortvergabe / Passwortverwaltung fir Schlisselpaare und
Keystore

o Detailanzeige von im Keystore befindlichen Zertifikaten und

Schllsselpaaren

o Exportfunktion fir Keystore Eintradge in mehrere Formate
Generierung von Zertifikats Anfragen (CSRs)
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Starten des i-effect Keymanagers

Da i-effect Keymanager ein Java-Programm ist, bendtigen Sie auf dem System, von
dem aus Sie i-effect Keymanager starten, eine installierte Version der Java Runtime
Umgebung (JRE). Falls Sie keine Java Runtime Umgebung auf diesem System instal-
liert haben und i-effect Keymanager als Keystore-Verwaltungsprogramm einsetzen
mochten, laden Sie sich bitte von eine aktuelle Java Runtime he-
runter. Nachdem Sie diese erfolgreich installiert haben, sollte sich i-effect Keymanager
durch einen Doppelklick auf die Datei ,i-effectKeymanager.jar’ starten lassen.

i-effect Keymanager |;‘ ‘El ‘X‘

File Tools Examine Help

HaBEBRPEER®

)| lias Name Last Madified

o keystors loaded

Offnen des i-effect-Keystore

Den Standard-Keystore von i-effect finden Sie im Verzeichnis /i-effect/<version>/crypt
unter dem Namen certificates.p12. Um diesen mit i-effect Keymanager zu 6ffnen,
gehen Sie wie folgt vor:

1) File -> Open Keystore File...(Strg+0)

2) In dem zur Anzeige kommenden Dialogfenster wechseln Sie bitte in das
Verzeichnis /i-effect/<version>/crypt. Wéhlen Sie die Datei certificates.p12
aus und bestéatigen Sie den Dialog mit Offnen.

Open Keystore File |ﬁ|
suchen int |[E3 CRYPT "‘ 5] D
E’é I3 error
Zuletat
werwendete
Dakumente
Desktop

B
=
Eigene Dateien

Arbeitsplatz

Q Dateiname: |EErt\fIEateS‘p12 | [ Affnen ]

Netzwerkumgebl r
Z Dateityp: |Keystore Files (*.ks;*.jks;* . pfx; ¥, p12) “ | Abbrechen

3) Um den Keystore 6ffnen zu kénnen mussen Sie zunachst das Passwort des
Keystore eingeben. Das Standardpasswort des Keystore certificates.p12 ist:
“jeffect”.

Password for Keystore ‘certifi... |:

Grafische Zusatzanvwendungen
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4q) Nachdem Sie das Passwort eingegeben und den Dialog mit OK bestatigt ha-
ben, werden die im Keystore certificates.p12 enthaltenen Eintrdge angezeigt:

:\i-effect\v1r3m2\CRYPT\certificates. p12 - i-effect Keymanager |Z”E‘El

File Tools Examine Help

LeaBaEECH BA@

@] Alias Hame Last Modified
as2.menten,com

as2gateway

deubsche belskom s 5

globialsign ront 5

globalsign ractsign partriers ca

Keystore type: PKCS #12, provider: BC, size: & entries

Bei den Eintrdgen handelt es sich um die Zertifikate von:

o Cybertrust
(Keystorealias: gte cybertrust global root )

o} Deutsche Telekom
(Keystorealias: deutsche telekom ca 4 (gte cybertrust global root)

o} menten GmbH
(Keystorealias: as2.menten.com)

Diese drei im Keystore enthaltenen Zertifikate bilden eine Zertifikatskette
(siehe Def. 1.9).

Erstellung eines Schliisselpaares

1)

2)

Um in einem Keystore ein Schllisselpaar anzulegen verwenden Sie bitte

Tools —> Generate Key Pair...(Strg + G)

Folgendes Dialogfenster 6ffnet sich:

Generate Key Pair El

Key Algorithm: (2 DSA @ RSA

ey Size: | 2048

Cancel

Wéhlen Sie RSA. aus.

RSA Das RSA-Kryptosystem ist ein asymmetrisches Kryptosystem,
d.h. es verwendet verschiedene Schlissel zum Ver und Ent-
schlUsseln. Es ist nach seinen Erfindern Ronald L. Rivest, Adi

Shamir und Leonard Adleman benannt.

DSA Der Digital Signature Algorithm ist ein Standard der US-Regie-

rung fur Digitale Signatur.

Nachdem Sie mit Ok Ihre Eingaben bestatigt haben, 6ffnet sich folgendes

Fenster:

Generate Certificate

®

Signature Algorithm:
walidity (days):
Cammon Mame {Ch):
Qrganisation Unit {OLI:
Organisation Mame (O):
Locality Mame (L):
State Mame (S5T):
Cauntry (C):

Emiail (E):

SHATwithRSA hd

T30
[asamentencom |
]
menten GmbH |
hew
oE|
[na@menterombnde |

Cancel
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3) Tragen Sie hier nun |hre Zertifikatsdetails ein und bestatigen Sie mit OK.

Weiter unten finden Sie eine Erlauterung der Eingabefelder. Belassen Sie die
Einstellung ,, Signature Algorithm™ auf ,, SHA1 with RSA! Im néachsten Dialog

werden Sie nun dazu aufgefordert dem eben generierten Schllisselpaar
einen Aliasnamen zu vergeben.

Key Pair Entry Alias f'5__<|

Enter Alias: |as2.menten.com

4) Die erfolgreiche Schltsselgenerierung wird lhnen mit einem weiteren Dialog

angezeigt. Bestéatigen Sie diesen mit OK um wieder zum Hauptdialog zu
gelangen.

Generate Certificate

-
- | ) Key Pair Generation Successful,

Wir empfehlen eine Schlisselldnge von 2048 Bit und eine Gultigkeitsdauer von 730
Tagen fir das Schlisselpaar zu verwenden.

Erlauterung der Eingabefelder

Signature Algorithm

Der Algorithmus, der verwendet werden soll, um die Signatur zu errechnen.

Validity (days)

Anzahl der Tage, die das erstellte Zertifikat gltig ist.

Common Name (CN)

Beim Importieren wird der CN als Aliasname fir das Zertifikat vorgeschlagen. Viele CAs
verlangen, dass als ‘Common Name' der Domainname verwendet werden muss, da
dieser eindeutig ist. Falls Sie Ihr Zertifikat von einer Certificate Authority signieren lassen

maochten, sollten Sie sich vor der Erstellung des Zertifikates tber die Vorgaben informie-
ren.

Organisation Unit (OU)
Die Einheit (z. B. Filiale, Niederlassung) der Organisation (z. B. Firma, Behorde). Dieses

Feld sollte allerdings nur ausgefullt werden, falls Ihre Organisation mehr als eine Einheit
besitzt.

Organisation Name (O)

Der Name Ihrer Organisation.

Locality Name (L)

Der Sitz Ihrer Organisation.

State Name (ST)

Der Name des Staates/Bundesland etc. in dem der Sitz lhrer Organisation ist.

Country (C)

Das Land, in dem |hre Organisation ihren Sitz hat.

Email (E)

Die eMail-Adresse lhrer Organisation.

Ihr Keystore beinhaltet nun ein glltiges Schlisselpaar:

E [Untitled] - i-effect Keymanager,

File Tools Examine Help

LoB&ESEPH RK @

@] s hame Last Modfied

&2 as2.menten.com

Keystore typs: FKCS #12, provider: BC, size: 1 entry
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5) Da Sie den Keystore um ein Schllsselpaar erganzt haben und somit den
Keystore verandert haben, ist es notig, die Anderungen im Keystore mittels

File—> Save Keystore (Strg+S)

zu speichern.

Das erstellte Schllsselpaar beinhaltet neben Ihrem privaten Schlissel auch lhren
offentlichen Schltissel. Um mit Ihren Partnern verschltsselte AS2-Nachrichten austau-
schen zu kénnen, ist es notig, Ihren Partnern Ihren 6ffentlichen Schllissel zukommen
zu lassen. |hren 6ffentlichen Schlissel kénnen Sie in Form eines Zertifikates exportie-
ren, was im Verlauf dieser Dokumentation noch weiter erklart wird.

Erstellung einer Zertifikatsanfrage
(Certificate Request)

Um lhr Zertifikat von einer hoheren Instanz, einer sogenannten Zertifizierungsstelle
(CA), signieren zu lassen, also damit Ihr eigenes Zertifikat beglaubigen zu lassen,
miussen Sie eine Certificate request erstellen. Um dies zu tun, gehen Sie bitte folgen-
dermaf3en vor:

1) Bewegen Sie den Mauszeiger Uber den Eintrag Ihres Schllsselpaares und
drlicken Sie die rechte Maustaste. In dem unten abgebildeten Kontextmen(
wahlen Sie den MenUpunkt Generate Certification Request.

[Untitled] - i-effect Keymanager

File Tools Examine Help

RaB KEEPEH AR

Alias Name

7 as2.menten.com

Last Modified

& Import CA Reply

@ st Password
T Delete

[ Clone
Rename

|Generate a certification request Far the key pair entry

2)

Es 6ffnet sich der unten abgebildete Speicherdialog.

Generate CSR |X|
Suchen in: ‘@ Diesktop "| I )ll
@ B Eigene Dateien
'J Arbeitsplatz

Zuletzt ==
verwendete \& Netzwerkumgebung

Dokumente

)

Deskiop

&

Eigene Dateien

Arbeitsplatz

Q Dateinare: ‘asz‘menten.com ‘ [ Generate l

Metzwerkumgebl Datsityp:

‘Certiﬁ:at\unRsuusstF\Ies(*.plﬂj*.csr) v‘ [ Abbrechen l

Wahlen Sie einen Ordner aus und vergeben Sie einen Namen fir Ihr Certi-
ficate Request. Bitte beachten Sie dabei, dass Sie eine der beiden Datei-
endungen mit angeben, die Ihnen unter Dateityp vorgeschlagen werden
(*.p10 ; *.csr). Danach bestatigen Sie den Speicherdialog mit Generate.

Um lhr Zertifikat von einer Certificate Authority signieren zu lassen, missen
Sie abschlieRend die eben erstellte Datei an die Certificate Authority lhrer
Wahl tGbertragen. Die Certificate Authority wird Ihnen nach erfolgreicher Vali-
dierung lhrer Daten ein signiertes Zertifikat zurlickschicken. Das von der CA
erhaltene Zertifikat muss nun wieder in lhren Keystore importiert werden.

[Untitled] - i-effect Keymanager
File REBEN Examine  Help

B Gererate Key P
B Import Trust:

Stro+G

. Last Modified
L8 Tmport Key Pair .. Strg+K

G Set Keystors Password...  Strg+P
B Change Keystore Type »
Keystore Report Strog+R
BZ options. ..

Import & trusted certificate inta the loaded keystore

Grafische Zusatzanvwendungen
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Ihr Zertifikat kdnnen Sie nun zusammen mit dem Zertifikat der Certificate
Authority an Ihre Partner versenden. |hr Zertifikat gilt somit als vertrauens-
wdurdig, allerdings muss dazu das Zertifikat der Certificate Authority, die Ihr

Zertifikat signiert hat, im Keystore Ihres Partners vorhanden sein, bevor Ihr
Zertifikat importiert wird.

Export des eigenen Zertifikats

Damit Sie mit Ihren Partnern unter Anwendung aller in AS2 zur Verfiigung stehenden
Sicherheitsmechanismen erfolgreich Daten austauschen kénnen, ist es notwendig,
Ihren Partnern lhren &ffentlichen Schllssel in Form eines Zertifikates zukommen zu
lassen. Um dieses Zertifikat mit Ihrem 6ffentlichen Schlissel zu erhalten, missen Sie
es aus |lhrem Schllsselpaar wie folgt exportieren:

1) Bewegen Sie den Mauszeiger Uber lhr Schllsselpaar und betatigen Sie die
rechte Maustaste.

Folgendes Kontextmenl kommt zur Anzeige:

C:\Dokumente und Einstellungenthamannt\Desktop\ertifikate und Keyslas2.m... |: E\E|
File Tools Examine Help

LangSEPE BR@

#lias Name

Last Modified

deutsche telelam ca 5 (gobalsig T Cortifiate Detsls
globalsign rock ca 5

i t
globalsign rootsiqn partners ca {

[ Generate Certification Request
& Import CA Reply

L 4

T Delete

[3 Clore

Rename

||'Expm the key pair entry

2)

3)

4)

Wahlen Sie in diesem Kontextmenu bitte den MenUpunkt Export.

Es 6ffnet sich folgendes Dialogfenster:

Andern Sie das Export-Format von DER Encoded nach PEM Encoded und
bestatigen Sie mit OK, um lhren &ffentlichen Schlissel als Zertifikat zu expor-

tieren.

Es 6ffnet sich ein Dialogfenster zum Speichern eines Zertifikates.

Zuletzt

verwendete
Dokumente

‘ G

Desktap

)

Arbeitsplatz

Eigene Dateien

Export Keystore Entry ‘as... E|

Expart Type
(3} Head Certificate
() Certificate Chain

Expart Format
() DER Encoded
(® PEM Encoded
(CIPKCS #7
) PhiPath

PKCS #12

() Private Key and Certificates

Export certificate

Suchen in: |_@ Desktop

v ¥ PEE

(L) Eigene Dateien
iJ Arbeitsplatz
& Netzwerkumgebung

‘g Dateiname: | asz menten,com.cer|

[ Export

J

Mg

Dateityp: ‘X‘SDQ Certificate Files (*.cer;*.crt)

v

[ Ankrschen

Wahlen Sie einen Ordner aus und vergeben Sie einen Namen fir lhr Zer
tifikat. Bitte beachten Sie dabei, dass Sie eine der beiden Dateiendungen
mit angeben, die Ihnen unter Dateityp vorgeschlagen werden (*.cer ; *.crt).

Danach bestatigen Sie den Speicherdialog mit Export.
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Import von Partnerzertifikaten

Um die Daten von AS2-Nachrichten, die Sie an Ihre Partner schicken wollen, verschlus-
seln zu kdnnen, ist es notwendig, dass die Zertifikate, die den 6ffentlichen Schllssel
Ihres Partners enthalten, im Keystore enthalten sind. Um die Zertifikate Ihrer Partner
in den Keystore zu importieren, gehen Sie bitte wie folgt vor.:

1) Tools —> Import Trusted Certificate...(Strg+T)

Folgendes Kontextmenl kommt zur Anzeige:

B Generate Key Pair... Strg+G
o ate... Strg+T

L8 mmport Key Pair... Strg+E. I Lot I

G Set Keystore Password..,  Strg+P

B Change Keystore Type >

a)

[ Keystore Report Strog+R

&= Options. .
||'1mpm a trusted certificate itk the loaded keystore

2) In dem folgenden Dialogfenster wechseln Sie bitte in das Verzeichnis, in

dem Sie das Zertifikat Ihres Partners abgelegt haben. \Wahlen Sie es aus und
bestétigen Sie das Dialogfenster mit Import.

Import Trusted Certificate
Suchenin: |1 Zertifikate und keys vl e E=
9 D-Trust_Test_CA_2003.cer

Zuletzt
verwendete
Dokumente

2

Desktap

=

¥

Eigene Dateien

Arbeitsplatz

Datelpame: | | [ tmpot |

@ﬁ

Nekzwerkumgebt
9= Dateityp: .50 Certficate Fles (*.cer;*.crt) v [ Abbrachen ]

Bei der Importierung von Zertifikaten kdnnen Ilhnen zwei Situationen be-
gegnen: Es besteht zum einen die Moglichkeit, dass das Zertifikat, welches
Sie importieren wollen, zwar Teil einer Zertifikatskette ist, das root-Zertifikat
(siehe Def. 1.9), oder von dem Zertifikat abhangige Zertifikate, nicht in lhrem
Keystore vorhanden sind. In diesem Fall, sowie wenn es sich um ein selbst-
signiertes (ohne CA Signatur) Zertifikat handelt, bekommen Sie folgenden
Hinweis von i-effect Keymanager angezeigt:

Import Trusted Certificate

i Could not establish a trust path For the certficate,

\) The certficate information will now be displayed after
which you may confirm whether or not you trust the
certificate.

Dieser Hinweis beschreibt den oben erlauterten Sachverhalt ebenfalls. Um
das Zertifikat lhres Partners selbst zu validieren werden lhnen, nachdem
Sie den Dialog mit OK bestéatigt haben, die Zertifikatsdetails angezeigt. Der
folgende Screenshot zeigt eine solche Detailanzeige.

Certificate Details for file ‘D-Trust_Test CA_2003.cer’

4 Certificate 1 of 1 b3

version:

Subject: ‘OID.Z‘5.4‘65=D—TRUST Test CA 2003 1:PN, CN=D-TRUST 1‘

Issuer: ‘OID.ZS.&GE:D-TRUST Tesk CA 2003 1:PM, CH=0-TRLST 1‘

Serial Number: ‘lDSZ |

Valid From: |02.10.2003 13:29:32 CEST |

wlid Ut |02.10.2009 13:29:32 CEST |

P o
Signature Algorithm:  SHALwithRSA

MDES Fingerprink: ‘QBJSG:ZC:UC:CE:15:ED:8D:06:FC:F3:24:73:9D:12:F2 ‘

SHA-1 Fingerprint: ‘US:B5:BD:UI:E5IEE:D7:FA:FC:D9:69:DD:EE:UC:UD:EF:D7:U‘

Anhand dieser Detailansicht konnen Sie das Zertifikat Ihres Partners selbst
validieren, um spéater nach Bestatigung des Dialoges mit OK zu entscheiden,
ob Sie diesem vertrauen oder nicht.

Import Trusted Certificate

:\.’H Do you want ko accept the certificate as trusted?

877
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Wenn Sie dabei nun das oben abgebildete Dialogfenster mit Ja bestatigen,
wird das Zertifikat, nachdem Sie im nachsten erscheinenden Dialogfenster
einen Aliasnamen fir das Zertifikat vergeben haben, im Keystore gespei-
chert. i-effect Keymanager wird lhnen automatisch den im Zertifikat unter
CN (Common Name) eingetragenen Namen als Aliasnamen flr das Zertifikat
vorschlagen. Sie kdnnen natdrlich das Zertifikat unter dem vorgeschlagenen
Namen oder einem selbst gewahlten Namen speichern. Den Aliasnamen
konnen Sie jederzeit ohne groRen Aufwand éndern.

Trusted Certificate Entry ... [Z|

Enter Alias! |d-trust|

Die zweite Situation, die Ihnen beim Importieren von Zertifikaten begegnen
kann, ist folgende: Falls das zu importierende Zertifikat von einer CA signiert
worden ist und somit Teil einer Zertifikatskette werden Sie zu keiner Validie-
rung der Zertifikatsdaten aufgefordert, wenn das root-Zertifikat der CA und
alle davon abhangigen Zertifikate in Inrem Keystore enthalten sind. Den oben
abgebildeten Bestatigungsdialog (Import Trusted Certificate) bekommen Sie
ebenfalls nicht angezeigt, da durch das Vorhandensein abhéngiger Zertifikate
in Ihrem Keystore die Vertauenskette (Certificate Chain) geschlossen ist und
das Zertifikat somit automatisch als vertrauenswiirdig eingestuft wird.

Andern eines Aliasnamens

1) Um einen Aliasnamen eines im Keystore gespeicherten Zertifikates zu an-
dern gehen Sie wie folgt vor:

Bewegen Sie den Mauszeiger Uber das Zertifikat, dessen Aliasnamen Sie
andern mochten und betétigen Sie die rechte Maustaste.

Folgendes Kontextmend kommt zur Anzeige:

\Dokumente und Einstellungenshamannt\Desktop\ertifikate und Keyslas2.m... |Z”E‘El

File Tools Examine Help
LB EY8CEEAS

Alias Name Last Modified

R Certificate Detalls

deutsche belekom ca 5 (globalsian rock

glohalsign rook ca i Export

globalsign rootsign partners ca (globsl [ Generate Certification Request
&, Tnport CA Reply

P
i Delate
[ clone

Rename the key pair entry

2) Nachdem Sie nun den MenUpunkt Rename ausgewahlt haben, wird Ihnen
das unten abgebildete Dialogfenster angezeigt. Tragen Sie hier bitte den
neuen Aliasnamen ein und bestatigen Sie das Dialogfenster mit Ok.

New Entry Alias

Enter Alias: |menken.com
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Erstellung eines neuen Keystores

1)

2)

Starten Sie i-effect Keymanager.

Das unten abgebildete Fenster kommmt zur Anzeige:

i-effect Keymanager
Fle Tools Examine Help

LeBEB8PEBER @

)| Alias Hame

Last Modified

|ﬁn keystore lnaded

Um einen neuen Keystore anzulegen, gehen Sie wie folgt vor:

File —> New Keystore (Strg + N)

Folgendes Dialogfenster 6ffnet sich:

New Keystore Type

3

Select the type of the new Keystare:

() JCEKS

OFBks
) UBER

3)

4)

Folgende Keystore-Formate werden unterstitzt:
o JKS: Java Keystore (Sun Keystore Format)

o PKCS#12: Public-Key Cryptography Standards #12 Keystore
(RSA's Personal Information Exchange Syntax Standard)

o JCEKS: Java Cryptography Extension Keystore
(More secure version of JKS)

o BKS: Bouncy Castle Keystore
(Bouncy Castle’s version of JKS)

o UBER: Bouncy Castle UBER Keystore
(More secure version of BKS)

Wahlen Sie hier bitte das Keystore Format PKCS#12 aus und bestéatigen Sie
mit OK. Sie kommen zurlick zu dem Hauptfenster. Nun kénnen Sie den neu
angelegten Keystore speichern, indem Sie folgendermafden vorgehen:

File -> Save Keystore / Save Keystore (Strg + S)

Sie werden dazu aufgefordert, ein Passwort flir den neu angelegten
Keystore zu vergeben.

Set Keystore Password

Enter Mew Password:
Confirm Mew Passward:

Nachdem Sie hier das Passwort eingegeben und bestatigt haben, kénnen
Sie den angelegten Keystore im Dateisystem lhrer iSeries speichern (Ver
gessen Sie hier bitte nicht, die Dateiendung entsprechend dem gewahlten
Keystore-Fomat mit anzugeben). Nach dem Speichern kehren Sie automa-
tisch zum Hauptfenster zurlick.

Save Keystore As rg‘
Speichernin: (@ Deskiop v 2 EE
b (L) Eigene Dateien
i§ Arbaitsplatz

» ef:‘::;;t . &3 nstzwerkumgebung

Dokumente

Desktop

=

Eigene Datsien

o

arbeitsplatz

‘g Dateinsme:  |keystore,p12 R

"9 Dateityp: | Keystore Fles (* ks ¥ jhs;* pf* p12) v [__Abbrechen |
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